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4 AT-9800 Series Switch
Models Covered By This Reference

This Hardware Reference includes information on the following products:

■ AT-9812T V2

■ AT-9816GB V2

■ AT-RPS9000 and AT-PWR9000

Hardware Overview

This section provides details about the physical characteristics of AT-9800 
Series switches. 

Switch Overview
Developed to meet the exceptionally high performance demands of high end 
applications, AT-9800 Series switches deliver hardware-based low-latency 
high-bandwidth wire speed Layer 2 and 3 switching, in a robust 1.5U platform.

With GBIC and 10/100/1000BASE RJ-45 port options bridging traditional 
copper/fibre divides, and hardware expansion options such as CompactFlash, 
CAM and DIMM, the AT-9800 Series is a versatile and powerful switching 
solution for rapidly evolving networks.

Dimensions ■ Height: 66mm, plus 5.5 mm if the rubber feet are used

■ Width: 440mm, excluding rack-mounting brackets

■ Depth: 360mm

■ Weight: Not more than 6.6 kg, depending on model and excluding power 
cord

Mounting System ■ 1.5U rack mounting

Environmental
Conditions

■ Operating temperature range: 0 to 40º C (32 to 104º F)

■ Storage temperature range: -25 to 70º C (-13 to 158º F)

■ Relative humidity range: 5 to 95% non-condensing

LEDs ■ Port and System status LEDs

■ For a complete list of LEDs and their functions, see “Switch LEDs” on 
page 7.

Power Supply Unit AC models

■ Universal 100–240 VAC, 50–60 Hz input

■ Redundant DC Power connection

DC models

■ 48 VDC (40–60 VDC is acceptable)

■ Accepts positive or negative earthing (grounding)
C613-03059-00 REV F



Hardware Reference 5
Maximum Current
Loads

AC models

■ Maximum continuous current draw: 2.2A at 220V, 4.3A at 110V

■ Maximum inrush current (cold start at 25º C/77º F): 60A at 220V, 30A at 
110V 

DC models

■ Maximum continuous current draw: 4.0A at -40V

Switching Core ■ Application-Specific Integrated Circuit (ASIC) switch chip

■ Non-blocking L2 and L3 IP Switching

■ 40 k-entry forwarding address database (expandable to 232 k-entries with 
LineCAM)

■ 64MByte RAMBUS packet buffer

Processing Core ■ 300MHz RISC Processor

■ 128MBytes Synchronous DRAM, expandable to 256MByte with DIMM

■ 16MBytes of fixed flash 

■ CompactFlash slot for hot swappable expansion of flash up to 512MBytes

■ 512kBytes of Non-volatile SRAM (NVRAM)

■ Battery backed real time clock (RTC)

■ 32/66MHz PCI bus

■ Silicon ID chip storing serial number, board ID, and MAC address

Asynchronous Serial
Port

■ Up to 115kbps

■ Universal Asynchronous Receiver Transmitter (UART)

■ Standard DB9 female RS-232 connector

■ Hardware-flow control

AT-9800 Series Switch Models
This section provides hardware descriptions for individual switch models.

AT-9812T V2 Key features are:

■ 12 10BASE-T/100BASE-TX/1000BASE-T ports (RJ-45 connectors)

■ 4 1000BASE-X ports (GBIC slots)

■ Unrestricted 1000BASE-T GBIC use

■ CompactFlash slot

■ DIMM socket for expansion of Synchronous DRAM

■ CAM socket for expansion of the forwarding address database 

■ Compatible with AT-PWR9000 RPS systems (AC models only)

■ Auto-negotiating Layer 3 Managed Switch

■ AC or DC PSU options
C613-03059-00 REV F



6 AT-9800 Series Switch
AT-9812T front panel

AT-9816GB V2 Key features are:

■ 16 1000BASE-X ports (GBIC slots)

■ Unrestricted 1000BASE-T GBIC use

■ CompactFlash slot

■ DIMM socket for expansion of synchronous DRAM

■ CAM socket for expansion of the forwarding address database 

■ Compatible with AT-PWR9000 RPS systems (AC models only)

■ Layer 3 managed switch

■ AC or DC PSU options

AT-9816GB front and rear panels
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AT-9812T V2 Multi-Layer Gigabit Switch
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AC INPUT
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L/A LINK / FULL DUP ACTIVITY

LINK / HALF DUP ACTIVITY

L/A

L/A ENABLED DISABLED FAULTGBIC

L/AL/A
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AT-9816GB V2 Layer 3 Fast Ethernet Switch
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Hardware Reference 7
Switch LEDs

The following LEDs report operations and faults on AT-9800 switches:

■ System LEDs

■ AT-9812T port and GBIC LEDs

■ AT-9816GB GBIC LEDs

System LEDs

AT-9812T
port and GBIC LEDs

LED State Function

PWR (Power) Green The switch is receiving power

Fault Red The switch or management software is 
malfunctioning

1 Flash A switch fan has failed or is operating below the 
recommended speed 

2 Flashes If RPS monitoring is enabled, an RPS fan has 
failed or is operating below the recommended 
speed

3 Flashes If an RPS is connected, the switch’s PSU (Power 
Supply Unit) has failed

4 Flashes If RPS monitoring is enabled, the RPS PSU has 
failed

5 Flashes If RPS monitoring is enabled, an RPS is not 
connected or is not operational

6 Flashes The temperature sensor located immediately 
adjacent to the switch chip has exceeded the 
recommended threshold of 60 degrees Celsius

RPS (Redundant Power 
Supply)

Green An RPS is connected to the switch and is receiving 
power

CompactFlash Activity
(Rear panel)

Green The CompactFlash memory is active. Do not eject 
the flash memory module.

LED State Function

GBIC L/A

(Link activity)

Green A 1000Mbps link is open. The link is operating in 
full duplex mode.

Flashing green 1000Mbps full duplex activity is occurring

Amber A 1000Mbps link is open. The link is operating in 
half duplex mode.

Flashing amber 1000 Mbps half duplex activity is occurring

GBIC Green A GBIC is installed and enabled

Amber A GBIC is installed but has not been recognised

Flashing amber A GBIC is installed and enabled, but a Tx fault is 
occurring

BASE-T L/A

(Link activity)

Green A 1000 Mbps link is open

Flashing green 1000 Mbps activity is occurring

Amber A 10/100 Mbps link is open

Flashing amber 10/100 Mbps activity is occurring
C613-03059-00 REV F



8 AT-9800 Series Switch
AT-9816GB
GBIC LEDs

BASE-T D/C

(Duplex/collision)

Green The port is operating in full duplex mode

Amber The port is operating in half duplex mode

Flashing amber Collisions are occurring

LED State Function

LED State Function

GBIC L/A

(Link activity)

Green A 1000 Mbps link is open. The link is operating 
in full duplex mode.

Flashing green 1000 Mbps full duplex activity is occurring

Amber A 1000 Mbps link is open. The link is operating 
in half duplex mode.

Flashing amber 1000 Mbps half duplex activity is occurring

GBIC Green A GBIC is installed and enabled

Amber A GBIC is installed but has not been recognised

Flashing amber A GBIC is installed and enabled, but a Tx fault is 
occurring
C613-03059-00 REV F



Hardware Reference 9
RS-232 Terminal Port (ASYN0)

The RS-232 ASYN0 terminal port is used to connect the switch to a 
management device for initial configuration and switch management tasks. 
This allows the switch software to be accessed from a terminal, a PC running 
terminal emulation software, or from a remote location via a modem 
connection. You can also use ASYN0 to establish a network connection from a 
remote site using SLIP and a modem.

ASYN0 has a DCE female socket. This allows the use of a straight-through 
cable when connecting the switch to a terminal or PC. Output from the show 
asyn command will, however, still have a DTE perspective. The DTE pin layout 
is shown in the following figure and table.

Pin Role

2 TXD

3 RXD

4 CD

5 GND

6 DTR

7 CTS

8 RTS

9 (Not used)

Pin 9 Pin 6

Pin 5 Pin 1

DB9 Female   Pin View
C613-03059-00 REV F



10 AT-9800 Series Switch
Gigabit Interface Converters (GBICs)

GBICs are removable gigabit port converters for switches that have GBIC bays. 
GBICs allow users to interchange port types to meet changing network 
requirements. GBICs can be purchased when a switch is purchased, or can be 
purchased separately as needed.

The following GBICs have been tested and approved for use with AT-9800 
Series switches:

■ Allied Telesis AT-G8T, 1000BASE-T, 100m

■ Allied Telesis AT-G8SX, 550m SX

■ Allied Telesis AT-G8LX10, 10km LX

■ Allied Telesis AT-G8LX25, 25km LX

■ Allied Telesis AT-G8LX40, 40km LX

■ Allied Telesis AT-G8LX70, 70km LX

For the latest list of approved GBICs, contact your authorised Allied Telesis 
distributor or reseller, or visit www.alliedtelesis.com/support/software.

For information on installing GBICs, see the AT-9800 Series Switch Quick 
Install Guide.

Any combination of copper and fibre GBICs can be installed in the AT-9812T 
and AT-9816GB switches.

Important RX and TX terminal locations on SC fibre GBIC ports are the reverse 
of RX and TX terminal locations on fixed SC fibre ports. When looking at an SC 
fibre GBIC from the front, the RX terminal is on the left and the TX terminal is 
on the right.

GBIC 1000BASE-T Auto-Negotiation
1000BASE-T GBICs support only 1000 Mbps full duplex connections. Although 
1000BASE-T GBICs will participate in auto-negotiation processes, they will 
only advertise 1000 Mbps. Half duplex, 10BASE-T, and 100BASE-TX modes are 
not supported.

While 1000BASE-T GBICs will auto-negotiate at the copper Ethernet level, the 
ports will behave as if in fixed 1000 Mbps full duplex mode. This is because the 
SERDES connection used by GBIC ports makes the auto-negotiation invisible 
to the switch, and so prevents a successful link negotiation.

When a 1000BASE-T GBIC is inserted into a GBIC slot, the port’s auto-
negotiation capability is disabled. This means that the port speed may not be 
set to "auto-negotiate". If the port has been configured to auto-negotiate (by 
default or by command) prior to the GBIC’s insertion, then this configuration is 
overridden for as long as the GBIC remains in place.
C613-03059-00 REV F
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Hardware Reference 11
Memory Options

The following memory expansion options are available:

■ CompactFlash Card

■ Content Addressable Memory (CAM)

■ Dual In-line Memory Modules (DIMMs)

CompactFlash Card
AT-9800 Series switches have a CompactFlash slot on their rear panel. 
CompactFlash cards increase the flash memory available for file storage.

CompactFlash files can be manipulated using the command line interface. Any 
type of data, including releases, patches, GUIs and configurations can be stored 
on CompactFlash cards. However, release, patch, and GUI files cannot be run 
directly from CompactFlash. These files must be loaded into either NVS or 
on-board flash. CompactFlash functionality is supported by Software Version 
2.5.1 and later.

Important Anyone with a compliant reader can read CompactFlash cards so 
do not keep sensitive data on them.

The following CompactFlash cards have been approved for use with AT-9800 
Series switches:

■ AT-CF032A-00 32MB CompactFlash card

■ AT-CF128A-00 128MB CompactFlash card

For the latest list of approved CompactFlash cards, contact your authorised 
Allied Telesis distributor or reseller, or visit www.alliedtelesis.com/support/
software.

Important AT-9800 Series switches support only CompactFlash cards with a 
maximum hardware access time of 100 nanoseconds.

Installing and removing a CompactFlash card
CompactFlash cards can be inserted into the CompactFlash slot at any time. It 
takes approximately two seconds for an inserted card to be initialised. The 
following CLI message confirms that the card has been inserted: 

Info (1106257): Compact flash card inserted.

The following message confirms that the card is ready to use:

Info (1106268): Compact flash card initialisation successful. 

The following message means that the CompactFlash card is not compatible 
with the switch:

Info (3106300): Compact flash card initialisation 
unsuccessful.

Important When data is being written to or read from the card, the 
CompactFlash Activity LED on the rear panel of the switch is green. Do not 
remove the card when it is active or you will corrupt the data. Wait until the LED 
is off before ejecting the card.
C613-03059-00 REV F
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12 AT-9800 Series Switch
Testing a CompactFlash card
To display information about the basic state of a CompactFlash card, including 
card size, file count and serial number, insert the card and enter the command:

show cflash

To display cluster ranges on a card, insert the card and enter the command:

show cflash test

The following figure is an example of output from the show cflash test 
command when no test is running.

To test a card, insert the card and enter the command:

enable cflash test start=startnumber end=endnumber

where startnumber and endnumber are positive integers within a cluster range. 
The endnumber must be higher than the startnumber. Cluster ranges are 
displayed in the output of the show cflash test command.

The test software will read the file allocation table and display a list of free 
sectors. Sectors can be tested as single sectors or as a range. The test will consist 
of a write/read/verify cycle. 

To stop the test, use the command:

disable cflash test

To display the test status while a test is in progress, use the command:

show cflash test

The following is example output from the show cflash test command when a 
test is running.

Error messages are displayed when a file write fails. Failure could be due to the 
card being removed or an error in the card.

Clusters available for testing
        Ranges:
               [42645--61944]
        Number of free clusters  = 19300
        Number of ranges         = 1
        Number of used clusters  = 42645

Test Progress
        Starting cluster          = 700
        Ending cluster            = 1700
        Current cluster           = 1185

        Passed clusters number    = 485
        Passed sectors  number    = 1940

        Failed clusters number  = 0
        Failed sectors  number    = 0
        Used Clusters encountered = 0

        Duration................  4417 ms
C613-03059-00 REV F
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Content Addressable Memory (CAM)
AT-9800 Series switches ship with 40 k-entries of CAM, as standard. This 
memory is divided into three fixed allocations:

■ 8 k for MAC address tables

■ 4 k for VLAN entries

■ 28 k for all other L2/L3 tables , such as IP route entries

CAM can be expanded through the purchase and installation of lineCAM. 
LineCAM is a 192 k-entry plug-in module that extends the Layer 2/Layer 3 
forwarding database from 40 k to 232 k. One lineCAM module can be installed 
in each AT-9800 series switch.

When lineCAM is installed, the memory allocations are:

■ 8 k for MAC address tables

■ 4 k for VLAN entries

■ 220 k for all other L2/L3 tables

LineCAM can be ordered as a pre-installed item when purchasing a switch, or 
can be purchased separately. For more information, contact your authorised 
Allied Telesis distributor or reseller.

To check how much CAM is installed, use the command:

show switch

For information on installing CAM, see “Restricted Procedures” on page 31.

Dual In-line Memory Modules (DIMMs)
Synchronous DRAM for AT-9800 Series switches is provided by a single 
DIMM. Two memory sizes are supported, 128 MBytes and 256 MBytes.

Warning Only Allied Telesis supplied DIMMs are tested and approved for use 
with AT-9800 Series switches. Using DIMM that has not been tested and 
approved may cause unreliable operation and will invalidate the switch’s 
warranty.

To check how much DIMM is installed, use the command:

show switch

For information on installing DIMMs, see “Restricted Procedures” on page 31.
C613-03059-00 REV F



14 AT-9800 Series Switch
Cables

This section describes how to construct management, test, and network cables 
for use with the switch’s RS-232 (ASYN0) and RJ-45 interfaces. 

RS-232 Terminal and Modem Cables
The terminal and modem cables described in this section are:

■ RS-232 DB9 male to female terminal cable

■ RS-232 DB9 male to male modem cable

Figures in this section show pin wiring diagrams to connect a standard VT100 
compatible terminal or modem to ASYN0.

RS-232 DB9 male to
female terminal

cable

Notes:
(1) → Output from switch; ← Input to switch.
(2) Cable version 1.0.

DB9MDB9Fsw

1 
2 
3 
4 
5
6
7
8
9

1
2
3
4
5
6
7
8
9

Cable

Pin 9 Pin 6

Pin 5 Pin 1

DB9 Female   Pin View
Pin 6 Pin 9

Pin 1 Pin 5

DB9 Male   Pin View

DB9 Male 
(to switch/DCE)

DB9 Female
(to PC/terminal/DTE)

Not connected
→ (TXD)
← (RXD)
← (CD)
    (GND)
→ (DTR)
← (CTS)
→ (RTS)
← (RING)

(DCD)
(RXD)
(TXD)
(DTR)
(GND)
(DSR)
(RTS)
(CTS)
(RING)
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RS-232 DB9 male to
male modem cable

For more information on pin assignments for the RS-232 port, see “RS-232 
Terminal Port (ASYN0)” on page 9.

Cables for RJ-45 Ethernet LAN Interfaces
A twisted pair cable with four pairs and RJ-45 connectors must be used for 
10BASE-T/100BASE-TX/1000BASE-T (10/100/1000BASE) connections. 

Caution Do not plug a phone jack into an RJ-45 switch port because you could 
damage the switch. Use only twisted pair cables with RJ-45 connectors.

Pin assignments Each pair of twisted pair cables is identified by related colours. For example, 
one wire might be red, and the related wire would be red-and-white stripe. An 
RJ-45 connector must be fitted to both ends of the cable. The following diagram 
shows RJ-45 connectors and the pin layout.

Notes:
(1) → Output from switch; ← Input to switch
(2) Cable version 1.0.

DB9MDB9Fsw

 
3 (TXD) 
2 (RXD) 
1 (DCD) 
5 (GND)
4 (DTR)
8 (CTS)
7 (RTS)
9
6 Not connected

1
2
3
4
5
6
7
8
9

Cable

Pin 9 Pin 6

Pin 5 Pin 1

DB9 Male   Pin View
Pin 6 Pin 9

Pin 1 Pin 5

DB9 Male   Pin View

DB9 Male 
(to switch/DCE)

DB9 Male
(to modem/DCE)

Not connected
→ (TXD)
← (RXD)
← (CD)
    (GND)
→ (DTR)
← (CTS)
→ (RTS)
     (RING)

1
8

1
8

RJPIN



16 AT-9800 Series Switch
1000BASE straight
through cable

For 1000BASE network connections, all four pairs are used and the cable is 
wired in a straight-through configuration. You can also use this cable with the 
software test facility, to test 1000BASE network ports. The following table lists 
pin assignments for a 10/100/1000BASE-T RJ-45 four pair straight-through 
cable.

1000BASE crossover
cable

For 1000BASE test cables, all four pairs are used and the cable is wired in either 
a crossover or straight-through configuration. The following table lists pin 
assignments for a 10/100/1000BASE-T RJ-45 four pair cross-over cable.

Cable Guidelines
The following table lists port, connector, and cable combinations for AT-9800 
Series switches and GBICs.

1. Refer to the IEEE 802.3 standards for further cable information.

End 1 End 2

Pin Pair Pin Pair

1 Pair 1+ 1 Pair 1+

2 Pair 1- 2 Pair 1-

3 Pair 2+ 3 Pair 2+

6 Pair 2- 6 Pair 2-

4 Pair 3+ 4 Pair 3+

5 Pair 3- 5 Pair 3-

7 Pair 4+ 7 Pair 4+

8 Pair 4- 8 Pair 4-

End 1 End 2

Pin Pair Pin Pair

1 Pair 1+ 1 Pair 2+

2 Pair 1- 2 Pair 2-

3 Pair 2+ 3 Pair 1+

6 Pair 2- 6 Pair 1-

4 Pair 3+ 4 Pair 4+

5 Pair 3- 5 Pair 4-

7 Pair 4+ 7 Pair 3+

8 Pair 4- 8 Pair 3-

Model Port Type
Connector 
Type Cable Type1

Maximum 
Cable Length

AT-9812T 10BASE-T/
100BASE-TX/
1000BASE-T

RJ-45 CAT5

CAT5E

100 to 150m

200m

AT-9816GB 1000BASE-X Varies with 
GBIC

Refer to 
documentation 
with GBIC

Refer to 
documentation 
with GBIC
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Hardware Reference 17
Redundant Power Supply (RPS)

Redundant Power Supply (RPS) units enhance network reliability by 
providing backup coverage for switch Power Supply Units (PSUs).

AT-9800 Series switches have an RPS connector on the rear panel. The 
connector allows the switch to be connected to an AT-RPS9000 system. The 
AT-RPS9000 must be purchased separately.

The AT-RPS9000 is a chassis that holds up to four removable AT-PWR9000 
power units. Each AT-PWR9000 power unit can provide redundant power to 
one AT-9812T or AT-9816GB switch. When fully loaded, the AT-RPS9000 
chassis can support up to four switches.

The AT-RPS9000 chassis has two AC power inlets. Each inlet supplies two 
bays, and therefore two AT-PWR9000 units and two switches.

Rear panel of the AT-RPS9000.

The pin layout and functions of the RPS connector on the rear panel of AT-9800 
Series switches are shown in the following figure and table.

AC INPUT A AC INPUT
100-240V

HZ
50/60

AMPS
5.0-2.5

AC INPUT B AC INPUT
100-240V

HZ
50/60

AMPS
5.0-2.5

RPS OUPUT A1 RPS OUPUT A2 RPS OUPUT B1 RPS OUPUT B2OUTPUT VDC A Max
16
16
0.5

+3.3
+5
+12

OUTPUT VDC A Max
16
16
0.5

+3.3
+5
+12

OUTPUT VDC A Max
16
16
0.5

+3.3
+5
+12

OUTPUT VDC A Max
16
16
0.5

+3.3
+5
+12

AT-RPS9000

AC Input A
(For RPS output A1 & A2)

AC Input B
(For RPS output B1 & B2)

RPS Output A1 RPS Output A2 RPS Output B2RPS Output B1

Power Switches

A1 A2 A3

6    7   8   9   10

1    2   3   4    5
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18 AT-9800 Series Switch
AT-RPS9000 Specifications

Dimensions ■ Height: 67 mm, plus 5.5 mm if the rubber feet are used

■ Width: 440 mm, excluding rack-mounting brackets

■ Depth: 360 mm 

■ Weight: 6.76 kg with one AT-PWR9000 installed, 10.21 kg with four 
AT-PWR9000 power units installed

Mounting System ■ 1.5U rack mounting

Environmental
Conditions

■ Operating temperature range: 0 to 40º C (32 to 104º F)

■ Storage temperature range: -25 to 70º C (-13 to 158º F)

■ Relative humidity range: 5 to 95% non-condensing

LEDs ■ AC supply to RPS

■ RPS fan, PSU, and connection fault, located on AT-9800 Series switches

■ RPS is supplying power to switch, located on AT-9800 Series switches

■ For LED descriptions, see “Switch LEDs” on page 7

Controls ■ Individual power switch for each PWR bay

■ Power switches recessed to prevent unintentional operation

AC Power Supply ■ Universal 100–240 VAC, 50–60 Hz input

DC Output ■ +3.3VDC/16A

■ +5VDC/16A

■ +12VDC/0.5A

Pin Number Function

A1 5VDC In

A2 Return (ground) for 5VDC In, 3.3VDC In, and 12VDC

A3 3.3VDC In

1 Ground to indicate RPS is present

2 Remote Sense (RS) +3.3VDC 

3 +12VDC In

4 RPS Fan Signal

5 Return (ground) for 5VDC In, 3.3VDC In and 12VDC

6 Remote Sense (RS) +5VDC 

7 Return (ground) for +3.3VDC and +5VDC Remote Sense (RS)

8 +12VDC In

9 Not Used

10 Return (ground) for 5VDC In, 3.3VDC In and 12VDC
C613-03059-00 REV F
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AT-TFTP Server

This section explains how to access and use the AT-TFTP Server. Use AT-TFTP 
server to download software upgrades to your switch, and transfer 
configuration files to and from your switch.

To use AT-TFTP Server, follow these steps.

1. If AT-TFTP Server has not yet been installed:

Install it now from the AT-9800 Series Switch Documentation and Tools 
CD-ROM.

Select AT-TFTP Server from the Start > Programs > Allied Telesis > 
AT-TFTP Server menu.

2. To set preferences for the AT-TFTP Server:

Select "Options" from the File menu to display the "Set Preferences" dialog 
box.

The "Default file transfer directory" field specifies the directory that 
AT-TFTP Server will read from or write to for file requests that do not 
include a directory specification.

To prevent unauthorised access to private directories, enter a path name in 
the "Restrict to directory" field. AT-TFTP Server will use only the specified 
directory, even if file requests contain references to other directories.

Select "Read only" to prevent files being written to the PC. To use the PC to 
archive scripts created using the create config command, select "Read 
Write".

Make any required changes and click "OK".

3. To load a file from AT-TFTP Server to the switch:

On a terminal connected to the RS-232 terminal port (ASYN0), use the 
command:

load method=tftp file=filename server=ipadd dest=flash

where filename is the name of the file to download and ipadd is the IP 
address of the PC running AT-TFTP Server.
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4. To save a TFTP Server log:

Select "Save As" from the File menu.

TFTP requests are logged to the AT-TFTP Server main window.

Using Windows Terminal and Windows 
Hyperterminal

You can use a PC running terminal emulation software as the manager console, 
instead of a terminal. There are many terminal emulation applications 
available for PCs, but the most readily available are the Terminal and 
HyperTerminal applications included in Microsoft Windows 98, 2000, and 
XP Professional. In standard Windows installations, HyperTerminal is 
available from the Communications submenu.

The key to successful use of terminal emulation software with the switch is to 
configure the software and switch with matching communications parameters. 
The following procedure can be applied to most terminal emulation programs. 
Dialog boxes in the procedure are from Windows 2000 and XP Professional.

To configure Windows HyperTerminal for 2000 and XP Professional

1. Start the program in Windows by doing one of the following:

• Select Programs > Accessories > Communications > HyperTerminal.

• Double-click the Hypertrm.exe icon.

2. In the Connection Description dialog box:

• Enter a name for the connection, such as Admin.

• Select an icon from the scrollable list and click the OK button.
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3. In the “Connect using” field on the Connect To dialog box, select the COM 
port on the PC used to connect to the switch. and click the OK button. 

4. In the COMn Properties dialog box, set port parameters as follows, and click 
the OK button.
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5. From the main HyperTerminal window, select Properties from the File 
menu. Click the Settings tab, and set the Properties dialog box as follows.

6. Click ASCII Setup to display the ASCII Setup dialog box, and ensure the 
following options are not selected:

• Echo typed characters locally

• Append line feeds to incoming line ends

Set other parameters as necessary and click the OK buttons on both dialog 
boxes to close them.   
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7. Save the current session by selecting Save from the File menu on the main 
HyperTerminal window. This creates a connection icon with the name you 
assigned in the HyperTerminal group. 

To use the configuration, double-click the connection icon. When the 
HyperTerminal window appears, press the Enter key several times; the 
switch’s login prompt is then displayed.

Switch Startup

This section describes the log in and startup procedures for your AT-9800 Series 
switch. Although the switch will perform basic switching operations without 
being configured, you will need to go through these log in and startup 
procedures if you wish to configure the switch and access its full layer 3 
switching capabilities.

To log In
To log in you must first connect the switch to a terminal or PC. This can be 
done using the RS-232 terminal port (ASYN0). A terminal cable suitable for use 
with ASYN0 is supplied with each switch.

Using the supplied terminal cable, or a cable you have made by following the 
instructions in “Cables” on page 14, connect your terminal or PC to ASYN0.

Set the communication parameters on your terminal or terminal emulation 
program to:

■ Baud rate: 9600

■ Data bits: 8

■ Parity: None

■ Stop bits: 1

■ Flow control: Hardware

See “Using Windows Terminal and Windows Hyperterminal” on page 20 for 
more information on configuring emulation software.

Ensure that any power switches are in the On position and that the switch is 
receiving power. 

After the switch has booted, the login prompt appears. If the login prompt 
doesn’t appear, press [Enter] two or three times.

When the switch boots for the first time it automatically creates an account 
with manager privileges. The account has the login name “manager” and the 
password is “friend”.

At the login prompt, enter the login name and password.

Log in: manager

Password: friend

The command prompt appears and you can now configure the switch using 
the command line interface.
C613-03059-00 REV F



24 AT-9800 Series Switch
Warning Change the password as soon as possible. Leaving the manager 
account with the default password is a serious security risk. Make sure that you 
remember the new password as there is no way to retrieve it if it is lost.

Use the following command to change the account password:

set password

See the AT-9800 Series AlliedWare™ Operating System Software Reference for more 
information on configuring the switch.

To access help
To use online help, the help file must be configured. Use the command:

set help=help-filename

where help-filename is the name of a help file stored in flash.

Help files have an .hlp extension. To see a list of files stored in flash, use the 
command:

show file

To display a list of help topics, use the command:

help

To display help on a specific topic, use the command:

help topic

where topic is the name of a help topic.

You can also type a question mark (?) at the end of a partially completed 
command to see a list of valid options.

Startup Procedure
When the switch starts up following either a power cycle or an operator-
initiated reboot (using the RESET button or restart command), it performs a 
series of self tests and sends messages to the terminal or PC connected to the  
ASYN0 port. After the switch successfully starts, a prompt is displayed for you 
to log in. See the Getting Started chapter in the Software Reference for more 
information about logging in.

Overrides The switch pauses briefly during routine startup messages to display the 
following prompt:

Force EPROM download (Y)?

If you do nothing, switch software is loaded along with a pre-configured 
startup script. For troubleshooting, you can change the startup process by 
using the following keys.

Pressing this key... Forces the switch to...

[Y] Load the EPROM release with no patch.

[S] Start with the default configuration so that any boot script is ignored.

[Ctrl/D] Enter diagnostics mode. For more information, see “Diagnostics” on 
page 37.
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Regular output The following figure shows a typical sequence of messages output during the 
startup process.

Types of messages The following table explains the types of messages that the switch generates 
during startup.

Startup messages The following table lists the possible startup messages and their meanings.

INFO: Self tests beginning.
INFO: RAM test beginning.
PASS: RAM test, 131072k bytes found.
INFO: BBR tests beginning.
PASS: BBR test, 512k bytes found.
INFO: Self tests complete
INFO: Downloading switch software.
Force EPROM download (Y) ?
INFO: Initial download succeeded
INFO: Executing configuration script <boot.cfg>
INFO: Switch startup complete

Manager >

Type Description

INFO An action will be taken by the system.

PASS A test has been completed successfully.

ERROR An error message that a test has failed, but the system continues to 
operate.

FAIL An error message that a fatal error condition has caused the system to 
halt in an unrecoverable fashion.

Message Description

INFO: Self tests beginning. Code loader tests are about to begin.

INFO: RAM test beginning. RAM tests are about to begin.

PASS: RAM test, 65536k bytes 
found.

RAM test passed and the switch is using the indicated 
amount of memory.

ERROR: RAM test test-number. 
Error address = address.

For example:
ERROR: RAM test 5. Error 
address = 00345678

The given RAM test failed at the given address, which 
means that the memory system is faulty. The test repeats 
until it passes. If the error continues, contact your 
authorised Allied Telesis distributor or reseller.

INFO: BBR tests beginning. BBR battery tests are about to begin.

PASS: BBR test. Battery OK. BBR battery tests passed.

ERROR: BBR Battery low. BBR battery test failed, indicating that the battery is 
running low. The BBR battery must be replaced. Contact 
your authorised Allied Telesis distributor or reseller.

PASS: BBR test, 512k bytes 
found.

BBR size/location test passed with the indicated amount of 
BBR found.
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Test Facility

The test facility is a hardware test tool in the switch software. Its primary 
function is to validate that there are no hardware problems after installation of 
the switch or expansion options. You can also use it as a troubleshooting tool, 
but it is just one of many such tools. You could consider the test facility to be a 
specialised interface module, such as PPP or Frame Relay, where the interfaces 
under test are dedicated to the test facility. 

Before you use the test facility, disable configurations by using the 
set configuration=none command, and restart or reboot the switch. For more 
information about the test facility, see the Test Facility chapter in the Software 
Reference.

FAIL: BBR test. Error address = 
address.

The BBR size/location test failed at the given location. The 
test at this location failed, indicating the end of memory, 
but a valid location was discovered in the 255 long words 
following this location. The BBR system must be replaced. 
Contact your authorised Allied Telesis distributor or 
reseller.

FAIL: BBR test, only 16k bytes 
found.

The BBR size/location test completed, but only the 
displayed amount of memory was found. This amount is 
less than the minimum required to run the switch 
software.

INFO: Self tests complete. The startup tests have finished.

INFO: Downloading switch 
software.

The process of downloading the switch software and 
vector table from ROM is about to begin.

ERROR: Code load retried.
FAIL: Code load failed.

Loading code from ROM to RAM failed. The load is retried 
a number of times, and the error message is displayed 
each time it fails. The FAIL message is displayed if the 
switch reaches the maximum number of attempts.

Force EPROM download? Prompt that lets you override the standard startup 
sequence, typically when troubleshooting.

INFO: Initial download 
succeeded.

Startup tests and download are complete, and the switch 
software is about to be started. The release is now 
decompressed. This may take a few seconds.

INFO: Downloading 
compressed release. This may 
take up to 1 minute...

INFO: Loading software into 
memory. This may take up to 1 
minute...

The main switch software is decompressed before being 
loaded into RAM.

INFO: Executing configuration 
script script-name

Configuration commands in the given script are being 
executed. If the script has an error, appropriate error 
messages are displayed.

INFO: Switch startup complete. The startup process is complete and the switch is now 
performing switching operations.

Message Description
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Testing Ethernet LAN Ports
A crossover cable is required to run an Ethernet LAN test. See “Cables” on 
page 14 for details of how to make a suitable cable. To start the test, loop a four-
pair crossover or straight-through cable between any two RJ-45 ports and enter 
the command:

enable test int=all

Note A loopback plug can also be used to test SC and MT-RJ GBIC interfaces.

All interfaces with loopback plugs fitted or connected by crossover cables are 
tested. Test results are displayed using the command:

show test

The following figure shows typical output from the show test command.

A more detailed output, with frame counts, can be displayed using the 
command:

show test count

Board      ID  Bay Board Name                      Rev    Serial number
----------------------------------------------------------------------------
Base      157      AT-9812TF                       P1-0   42029694

                                              Duration       Details
Interface  State    Result              Type  (minutes)  Data( %OK )  Control
----------------------------------------------------------------------------

  port1   testing   wait 4 minutes      TP         < 1   GOOD (100.0)  -
  port2   no test     -                  -           -    -     -      -
  port3   no test     -                  -           -    -     -      -
  port4   testing   wait 4 minutes      TP         < 1   GOOD (100.0)  -
  port5   no test     -                  -           -    -     -      -
  port6   no test     -                  -           -    -     -      -
  port7   no test     -                  -           -    -     -      -
  port8   no test     -                  -           -    -     -      -
  port9   no test     -                  -           -    -     -      -
  port10  no test     -                  -           -    -     -      -
  port11  no test     -                  -           -    -     -      -
  port12  no test     -                  -           -    -     -      -
  port13  no test     -                  -           -    -     -      -
  port14  no test     -                  -           -    -     -      -
  port15  no test     -                  -           -    -     -      -
  port16  no test     -                  -           -    -     -      -

  asyn0   testing   wait 4 minutes       -         < 1    -     -      -
----------------------------------------------------------------------------
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The following figure shows typical output from the show test count command.

Important If a test fails, contact your authorised Allied Telesis distributor or 
reseller.

Board      ID  Bay Board Name                      Rev    Serial number
----------------------------------------------------------------------------
Base      157      AT-9812TF                       P1-0   42029694

                          Duration                   Frame Counters
Interface  State    Type  (minutes)         Tx    RxTotal     RxGood      RxBad
--------------------------------------------------------------------------------

  port1   testing   TP         < 1   000298842  000298841  000298841  000000000 
  port2   no test    -           -           -          -          -          -
  port3   no test    -           -           -          -          -          -
  port4   testing   TP         < 1   000298842  000298841  000298841  000000000 
  port5   no test    -           -           -          -          -          -
  port6   no test    -           -           -          -          -          -
  port7   no test    -           -           -          -          -          -
  port8   no test    -           -           -          -          -          -
  port9   no test    -           -           -          -          -          -
  port10  no test    -           -           -          -          -          -
  port11  no test    -           -           -          -          -          -
  port12  no test    -           -           -          -          -          -
  port13  no test    -           -           -          -          -          -
  port14  no test    -           -           -          -          -          -
  port15  no test    -           -           -          -          -          -
  port16  no test    -           -           -          -          -          -

  asyn0   testing    -         < 1   000000000  000000000  000000000  000000000
--------------------------------------------------------------------------------
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Troubleshooting 

This section provides information on how to detect and resolve problems with 
AT-9800 Series switches and their expansion options.

Other sources of useful troubleshooting information are:

■ www.alliedtelesis.com/support/software.

■ The AT-9800 Series AlliedWare™ Operating System Software Reference.

Check these first
1. Check the power cord connections.

2. Check that the power supply voltage is stable.

3. Check that the correct data cables are being used and that their connections 
are secure.

4. Check that any GBICs are correctly installed and that they are compatible 
with the switch. See “Gigabit Interface Converters (GBICs)” on page 10 for 
more information.

5. Make sure that other network devices are working properly.

6. Use the show install command to check that the latest software release is 
loaded. See the AT-9800 Series AlliedWare™ Operating System Software 
Reference for more information about obtaining the latest software release.

7. If the switch is malfunctioning, reboot it by pressing the recessed RESET 
button or entering the command restart reboot. Alternatively, shut down 
and restart the switch using its power switch (AC models) or  as appropriate 
(DC models).

Common problems and how to solve them

Link/Activity LED on
any port is off

This can indicate:

■ a loose data cable

■ the device at the other end of the connection is not working properly or is 
turned off

■ the data cable is not wired correctly

■ the network administrator has manually disabled the port through the 
software

■ the port’s selected transmission mode does not match that of the attached 
device

Perform the following steps in sequence:

1. Make sure the data cable connections are secure.

2. Make sure the device at the other end of the connection is switched on and 
working properly.

3. Check that the data cable is wired correctly.

4. If you can, log in and check the port status. See “To log In” on page 23 for 
more information on how to log in.
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5. If the port is enabled, make sure the transmission speed matches that of the 
connected device (auto-negotiating, full or half-duplex).

Important If the port is disabled, someone has used the software to 
manually disable it. You should find out why the port was disabled before 
enabling it.

Power LED is off This can indicate:

■ a loose power cord

■ a power supply failure

Perform the following steps in sequence:

1. Check that the power cord connections are secure.

2. Check that all switches and circuit protection devices are in the ON position.

3. Ensure that the supply voltage is within the operational range: 100–240 VAC 
and 50–60 Hz for AC models, or 40–60 VDC for DC models.

Fault LED is on This can indicate:

■ there is a problem with the switch or PSU

■ the switch or management software is malfunctioning

■ a hardware fault is preventing switch startup

Perform the following steps in sequence:

1. Check “Switch LEDs” on page 7 for descriptions and explanations of LED 
flashing sequences.

2. Reset the switch by pressing the recessed RESET button on the front panel.

3. If you were attempting to download software or manage the switch via the 
RS-232 terminal port, check that connections between the terminal port and 
local terminal or PC are secure.

If you cannot access the switch’s software because of a faulty RS-232 
terminal port connection, you can still manage the switch via Telnet or 
SNMP until the problem is fixed.

4. Download the latest software release. See the AT-9800 Series AlliedWare™ 
Operating System Software Reference for more information on how to obtain 
the latest software release.
C613-03059-00 REV F



Hardware Reference 31
Restricted Procedures

This section contains procedures that should only be performed by authorised 
service personnel. Unauthorised use of procedures in this section may cause 
danger of injury from electric shock, damage to the switch, and invalidation of 
the product warranty. 

If you would like to know more about the procedures outlined in this section, 
please contact your authorised Allied Telesis distributor or reseller.

Installing CAM
LineCAM is available as a 192 k-entry module. Adding a LineCAM module 
extends the switch’s Layer 2/Layer 3 forwarding database from 40 k-entries to 
232 k-entries. One LineCAM module can be installed in each AT-9800 series 
switch.

LineCAM can be ordered as a pre-installed item when purchasing a switch, or 
can be purchased separately and installed as needed.

Warning For AT-9800 Series switches, CAM should only be installed by 
authorised service personnel. Unauthorised opening of the switch’s lid may 
cause danger of injury from electric shock, damage to the switch, and 
invalidation of the product warranty. 

To install LineCAM in an AT-9800 series switch:

1. Avoid injury by working in a safe environment.

The workspace should be free of hazards, and there should be sufficient 
room to lay out the switch, CAM, and tools.

2. Unpack the CAM in an antistatic environment.

Warning Do not attempt to install any hardware without observing correct 
antistatic procedures. Failure to do so may damage the switch or CAM. If you 
are unsure what the correct procedures are, contact your authorised Allied 
Telesis distributor or reseller.

3. If fitted, disconnect the switch’s redundant power supply.

4. Disconnect the mains power cord.

Warning Before removing the switch’s lid, the power cord and, if connected, 
RPS power cord should be disconnected to reduce risk of electrical shock.

5. Remove all interface cables.

6. Remove the switch’s lid.

The switch may need to be removed from any rack mounting system 
before its lid can be removed.

Using a posidrive screwdriver, remove the 12 screws that secure the 
switch’s lid. There are 5 screws located in countersunk holes on each side 
of the lid, and 2 screws at the rear. 
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7. Align the CAM.

Position the CAM over the CAM slot on the switch base board, as shown in 
the following figure. The three support pillars located on the board should 
be aligned with the holes on the CAM, and the CAM’s chamfers should be 
pointing to the switch’s PSU.

8. Insert the CAM.

Warning Forcing a misaligned CAM will damage the CAM’s connector and 
CAM slot.

Press the CAM firmly into place. Secure the CAM to the support pillars 
using the supplied screws. 

The CAM is now ready to test.

CAM mounts

Switch chip

CAM slot

BatteryCompact Flash

DIMM slot

CPU

Ports

Correct CAM 
orientation

Chamfers
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Testing CAM
To check that the switch has recognised the CAM, turn on the switch and enter 
the command:

show switch

This displays system system information, including the amount of CAM 
installed. The following figure is an example of output from the show switch 
command.

If there is no entry for the CAM, or the entry displays an incorrect value, then 
the switch has not correctly detected the CAM’s presence. The most likely 
cause is that the CAM is not correctly plugged into the CAM slot. Repeat the 
installation process, paying particular attention to the CAM alignment and 
insertion steps.

Use the show switch command again, and if the display is still not correct, 
contact your authorised Allied Telesis distributor or reseller.

Important If any CAM test fails, check that the CAM is correctly installed in its 
slot and repeat the tests. Contact your authorised Allied Telesis distributor or 
reseller if the CAM does not operate correctly.

 Switch Configuration
------------------------------------------------------------
 CAM size ( entries ) ....... 204800
 Switch Address ............. 00-00-cd-05-01-0f
 Learning ................... ON
 Ageing Timer ............... ON
 Number of Fixed Ports ...... 16
 Number of Uplink Ports ..... 0
 Mirroring .................. DISABLED
 Mirror port ................ None
 Ports mirroring on Rx ...... None
 Ports mirroring on Tx ...... None
 Ports mirroring on Both .... None
 Number of WAN Interfaces ... 0
 Name of Interface(s) ....... -
 Ageingtime ................. 300
 VLAN classification ........ To be defined
 UpTime ..................... 00:01:21
 Hashingfiled ............... L2 L3 L4
 -----------------------------------------------------------
C613-03059-00 REV F



34 AT-9800 Series Switch
Installing DIMM
AT-9800 Series switches have one DIMM slot. The slot can be populated with 
either a 128 MByte DIMM or a 256 MByte DIMM.

Warning Only Allied Telesis supplied DIMMs have been tested and approved 
for use with AT-9800 Series switches. Using DIMM that has not been tested and 
approved may cause unreliable operation and will invalidate the switch’s 
warranty.

Warning For AT-9800 Series switches, DIMM should only be installed by 
authorised service personnel. Unauthorised opening of the switch’s lid may 
cause danger of injury from electric shock, damage to the switch, and 
invalidation of the product warranty. 

To install DIMM in an AT-9800 series switch:

1. Avoid injury by working in a safe environment.

The workspace should be free of hazards, and there should be sufficient 
room to lay out the switch, DIMM, and tools.

2. If fitted, disconnect the switch’s redundant power supply.

3. Disconnect the mains power cord.

Warning Before removing the switch’s lid, the power cord and, if connected, 
RPS power cord should be disconnected to reduce risk of electrical shock.

4. Remove all interface cables.

5. Remove the switch’s lid.

The switch may need to be removed from any rack mounting system 
before its lid can be removed.

Using a posidrive screwdriver, remove the 12 screws that secure the 
switch’s lid. There are 5 screws located in countersunk holes on each side 
of the lid, and 2 screws at the rear. 

6. Prepare the DIMMs.

In an antistatic environment, remove the DIMM from its packing material. 
Be sure to observe ESD precautions.

Warning Do not attempt to install DIMM without observing correct antistatic 
procedures. Failure to do so may damage the DIMM and switch. If you are 
unsure what the correct procedures are, contact your authorised Allied Telesis 
distributor or reseller.

7. Remove the existing DIMM.

Warning Before removing the switch’s lid, the power cord and, if connected, 
RPS power cord should be disconnected to reduce risk of electrical shock.

The DIMM is held in place by two retaining latches, one latch at each end 
of the DIMM slot. Release these latches and carefully pull the DIMM from 
the DIMM slot.
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The DIMM slot’s location is shown in the following figure.

8. Align and insert the new DIMM.

Holding a DIMM at an angle of about 30 degrees from horizontal, align the 
notches on its connector strips with the notches on the empty DIMM slot, 
as shown in the following figure.

Insert the DIMM into the DIMM slot, sliding it along the two DIMM 
guides until the retaining latches automatically click into place. The latches 
should hold the DIMM firmly in place.

Testing DIMM
The switch is unlikely to boot unless the DIMM is correctly installed. If the 
switch does boot but you suspect the DIMM is malfunctioning, enter the 
command:

show system

CAM mounts

Switch chip

CAM slot

BatteryCompact Flash

DIMM slot

CPU

Ports

Correct CAM 
orientation

Chamfers

DIMM

DIMM slot

Ports

CAM slot
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The following figure is an example of output from the show system command 
for an AT-9800 Series switch.

The Memory field displays the size of DRAM. If the DRAM size is less than the 
size of DIMM that has been installed, then the switch has not correctly detected 
the DIMM. The most likely cause is that the DIMM connector is not plugged 
into its slot correctly. Repeat the installation process, paying particular 
attention to the DIMM insertion step.

Use the show system command again, and if the display is still not correct, 
contact your authorised Allied Telesis distributor or reseller.

Important If you have any difficulty with the DIMM at any time, contact your 
authorised Allied Telesis distributor or reseller and quote the serial numbers of 
both the base card on the switch and the DIMM. The switch’s serial numbers 
and revision details can be read using the show system command. It’s a good 
idea to record this information for later reference.

Switch System Status                            Time 11:25:50 Date 28-Mar-2002.
Board      ID  Bay Board Name                      Rev    Serial number
--------------------------------------------------------------------------------
Base      156      AT-9816GF                       M1-1   46709354
--------------------------------------------------------------------------------
Memory -   DRAM : 65536 kB    FLASH : 15360 kB
--------------------------------------------------------------------------------
SysDescription
Allied Telesis AT-9816GF version 2.5.1-00 10-Nov-2002
SysContact

SysLocation

SysName

SysDistName

SysUpTime
3382 ( 00:00:33 )
Boot Image      : 98-101.fbr size 903404 20-Aug-2002
Software Version: 2.5.1-00 10-Nov-2002
Release Version : 2.5.1-00 10-Nov-2002
Release built   : Nov 10 2002 at 00:20:31
Patch Installed : NONE
Territory       : usa
Help File       : help.hlp

Main PSU        : On          Main Fan        : On
RPS Monitor     : On          RPS Connected   : ***NO***

Current Temperature : 29 C

Configuration
Boot configuration file: snoopy.cfg (exists)
Current configuration: snoopy.cfg

Security Mode   : Disabled

Warning (2048283): No patches found.
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Diagnostics

The switch software includes a set of diagnostic programs that perform basic 
checks of all system components. These diagnostics do not run with normal 
operating code and require that the system be totally dedicated to their use. 
The switch does not perform switching operations when diagnostics are 
running.

Caution Diagnostics are designed to be run by service personnel only. This 
section is not intended as a guide to the diagnostics software. Detailed 
knowledge of how the switch hardwre functions is necessary in order to 
effectively use these diagrnostic programs. For more information, contact your 
authorised Allied Telesis distributor or reseller.

To enable diagnostics mode:

1. Connect a terminal to the RS-232 terminal port (ASYN0).

Using a terminal cable, connect a terminal to the RS-232 port (ASYN0) on 
the switch. See “Cables” on page 14 for more information on terminal 
cables. Set the terminal communication parameters to the following:

• Baud rate: 9600

• Data bits: 8

• Parity: None

• Stop bits: 1

• Flow control: Hardware

2. Restart the switch.

Restart the switch, either by using a pen or pencil to operate the recessed 
RESET button on the switch’s front panel, or by using the terminal to log in 
and enter the command:

restart reboot

See “To log In” on page 23 for more information on how to log in.

3. Enable diagnostics mode during start-up.

During the switch startup process, at the prompt:

Force EPROM download (Y)?

press [Ctrl/D] on the terminal to enter diagnostics mode. The following 
menu is displayed. When you see the menu, you know that the terminal is 
connected.

* * * Diagnostic Mode * * *

  version 16-Mar-98
  
Main Menu:
  0. Restart
  1. Full RAM test
  2. ROM checksum test 
  3. Full FLASH test
  4. Totally Erase FLASH
  5. Battery backed RAM test
Enter selection ==>
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Warning Performing a full flash test or erasing flash will delete all 
configuration and release files. Make sure you know how to reload these files 
before erasing flash or performing a flash test.

To run a diagnostic program, enter the corresponding letter or number (or key). 
There are several sub-menus to cover all the available options. Control keys for 
diagnostic operations are shown in the following table.

A reasonable understanding of the system’s structure is needed to operate 
diagnostics and interpret the results.

To restore the switch to normal operation, use a pen or pencil to operate the 
recessed RESET button on the front panel, or press “0” (zero) to restart.

For More Information

Documentation Set The Documentation and Tools CD-ROM bundled with each switch contains the 
complete document set for AT-9800 Series switches and their expansion 
options, as well as tools for switch management. The CD-ROM includes:

■ The AT-9800 Series Statutory and Safety Information booklet, which includes 
important safety information and statutory declarations for AT-9800 Series 
switches.

■ The AT-RPS9000 Statutory and Safety Information booklet, which includes 
important safety information and statutory declarations for the 
AT-RPS9000 chassis and AT-PWR9000 power unit.

■ The AT-9800 Series Switch Quick Install Guide, which outlines the procedure 
for installing AT-9800 Series switchs.

■ The AT-RPS9000 & AT-PWR9000 Quick Install Guide, which outlines the 
procedure for installing AT-RPS9000 chassis and AT-PWR9000 power 
units.

■ The AT-9800 Series Switch AlliedWare™ Operating System Software Reference, 
which provides detailed information on configuring the switch and its 
software.

■ The CAM Quick Install Guide, which outlines the procedure for installing 
Content Addressable Memory.

■ AT-TFTP Server for Windows, for downloading software releases.

■ Adobe Acrobat Reader, for viewing online documentation.

You can also download these documents and updates from
www.alliedtelesis.com/support/software.

Key Function

Q Quits test that are running tests and displays the banner page.

S Prints a summary of test results so far.
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Viewing
documentation on

the CD-ROM

1. Insert the Documentation and Tools CD in the CD-ROM drive.

If the browser menu does not appear, select Run from the Start menu. Then 
type d:\start.exe (where d: is the CD-ROM drive) in the text box, and click 
the OK button.

2. Install Adobe Acrobat Reader from the CD if necessary. It must be installed 
in order to view the documentation.

3. To view a specific document, click the document title.

4. To browse PDF documents, use any of the following to page through a 
document:

• toolbar buttons, such as the Next Page button

• keyboard shortcuts, such as arrow keys

• commands from the Document menu

• mouse wheel

To go to a specific section or topic, click a bookmark, thumbnail, or 
hypertext link.

Use the Search command to search for keywords or phrases.

For more information about using the Adobe Acrobat Reader, select Adobe 
Reader Help from the Help menu.

5. To install one of the tools from the CD, click the link on the browser menu. 

Contacting Us With locations covering all of the established markets in North America, Latin 
America and Europe, Allied Telesis provides localized sales and technical 
support worldwide. To find our representative nearest you, visit Allied Telesis 
on the web at www.alliedtelesis.com.
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